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There are several ways to bring up the main request dialog. They are as follows:

||

Ctri+E Edits the selected request. You can also double click on the Field # column, or if it is
ﬁ already highlighted simply press the ENTER key.
’I Ctrl+A Adds a request to the end of the currents sport’s file.
|
Ctrl+l Insert a request in front of the currently selected request.

-

Arequest can be added at any time. However, before a request can be edited or inserted, you must select one and only one
request. When the entire request is selected the whole row or request will appear highlighted. This can be done by clicking on
the Field # column or using the arrow keys to do the same thing.

The following are all of the parts that make up the main request dialog.

Request #: This can not be edited via this dialog. It is simply the number for the request. Each
request has its own unique number.
Description; This is to help the user remember which statistics and sequences each request will call up

or display. Again, this is only for the user and is not used by the Stat Request application or
the Venus application.

Type: Team and Individual or the only two types of requests.
Top 3: Top 3 is only used for Individual(not team) football requests. It will show the top 3

individuals for the desired statistics. You can choose from Passing, Receiving, Rushing,
and Tackles/Defense. If you do not want the top 3 performers select the Normal setting for

this field.

Sty|e; Currently, only in-game statistics are available. Future releases may have the ability to do
either Season or Game statistics.

Sign #: Will determine which sign to send the request to. The Venus 7000 can control up to 16

signs, so, the possible entries are 1-16. The sign number parameter must be configured in
the Venus software. Please refer to the Venus manual or help file for more information on
sign number.

Display Mode: Can be any one of the three possible options. Continuous, Single Step, or Selected
Frame. Most RTD(real time data) sequences will probably be displayed in Selected frame
mode. Please refer to the Venus manual or help file for more information on display modes
and RTD.

Times to Display: This will tell the Venus how many times to play the desired sequence. It is only used when
displaying in Continuous mode.

Drive: This is the Letter of the drive for which the desired sequence can be found. In most cases
this will be the local hard drive, which would be the C drive.



Library:

Sequence:

Frame #:

Offset:

This is the name of the directory which the desired sequence can be found in. Due to
backwards compatibility with DOS programs, this has to be 8 or less characters. You do
not need to add the .LIB extension.

This is the name of the desired sequence to run. Due to backwards compatibility with DOS
programs, this has to be 8 or less characters. You do not need to add the .SQ7 or .SEQ
extensions.

This tells the Venus which frame to show when displaying sequences in Selected Frame
mode.

This will send the requested information to the desired Offset into the Venus input RTD
buffer. In most cases this will be 0. However, there are times when a Venus input RTD
buffer will be receiving two different streams of information, in this case you will have to set
the request to a certain offset so as not to overwrite any other information which is already
in the buffer.

Press on OK to save the settings. Press on CANCEL to discard any settings or changes.



Send Request

This can also be referred to as Launching a request. To send a request you must first highlight the entire request to be sent.
This can be done by using the mouse or arrow buttons and select the corresponding Field # column for the desired request to

send.

Once the request is highlighted:

|

Toolbar:
Keys: CTRL+R

Shortcut:
Using the mouse right click on the field # column corresponding to the request you wish to send.



Sports

Currently only DakStats Football and Basketball have been fully developed to work with the Venus controllers. Baseball will
be added soon.

Eventually there will be a family of DakStats results packages to incorporate into your Daktronics control equipment.
Baseball
Basketball
Football

Hockey
Soccer

Volleyball

To Change Sport files:
Click on the File Menu, then click on Sport. Finally, click on the name of the desired sport.



Edit
The edit option is only available if the whole request is highlighted. To do this use the mouse or arrow keys to select the Field #
column. It will bring up the Main Request Dialog .

Shortcut:

14

Toolbar:
Keys: CTRL+E



Delete

Delete does NOT copy the selected items to the clipboard. The delete option is only available if the whole request is
highlighted. To do this use the mouse or arrow keys to select the Field # column. You can delete multiple requests at the same
time. You will be prompted to verify the delete.

Shortcut:

bad
Toolbar:

Keys: CTRL+D or the DELETE key



Add

Add will add a empty template of a request to the end of the current sport file. It will bring up the Main Request Dialog .

Shortcut:

E

Toolbar:
Keys: CTRL+A



Insert

The insert option is only available if the whole request is highlighted and only one single request is highlighted. To do this use
the mouse or arrow keys to select the Field # column.

Insert will add a empty template of a request in front of the request currently selected. It will bring up the Main Request Dialog .

Shortcut:

o

Toolbar:
Keys: CTRL+I



What is a Request

In short, a request is a command to receive data from another source.

Arequest is a set of parameters that will be sent to the DakStats computer. The DakStats computer receives the request then
sends the requested information to the Venus Controller(s)

You can request an entire Team’s statistics or statistics for Individual players on either team. These statistics will continuously
be updated with every play entered by the DakStats operator. These statistics can be displayed by your Venus controller to any
sign being controlled by the Venus. The statistics are displayed using RTD(real time data) frames which make up a Venus
sequence.

Besides sending the statistics, the request will also send control parameters which will automatically start up a desired sequence
in the desired display mode on the desired sign. To see all of the different parameters that make up a request see the Main
Dialog Request .

There really isn’t a limit to the number of requests or the number of sequences on which to display your teams statistics.



Shortcut Keys

Once you are acquainted with the software you may find it easier to use the keyboard instead of the mouse to navigate through
various commands. Here is list of various Shortcut Keys.

CtrI+E Edit a Request(See Commands, Edit Menu)

Ctrl+A Add a Request(See Commands, Edit Menu)

Ctrl+l  Insert a Request(See Commands, Edit Menu)

Ctrl+X Cut selected Requests to the Clipboard(See Commands, Edit Menu)
Ctrl+C Copy selected Requests to the Clipboard(See Commands, Edit Menu)
Ctrl+V  Paste Clipboard contents(See Commands, Edit Menu)

Ctrl+D Delete selected Requests(See Commands, Edit Menu)

CtrI+R  Send selected Request(See Commands, File Menu)

Ctrl+S  Save current sport’s Requests(See Commands, File Menu)

Ctrl+P  Print the current sport’'s Requests(See Commands, File Menu)

You can also use the keyboard to edit individual fields of a request without bringing up the Main Request Dialog .
See Editing Individual Fields




Editing Individual Fields

Besides using the Main Request Dialog, you can edit individual fields by highlighting the desired field(column) of a single request
or by highlighting the desired field(column) of several requests.

There are also_shortcut keys which will help you edit individual fields.

To edit a field of a single Request:
First, highlight or select it by using the mouse or arrow keys. You can do this by double clicking with the mouse button.
If it is already highlighted simply press the ENTER key.

To edit a field of multiple Requests:
First, highlight or select the first request’s field by using the mouse or arrow keys. Next, hold the shift key down and
use the arrow keys or mouse to select the last request you wish to edit. Finally, press the ENTER key to edit the fields.

Depending on which field you selected one of two dialog boxes will pop up.

The following dialog expects you to type in a string and then press OK or CANCEL. If you press OK or ENTER it will take the
string and set all selected strings to that value.

Enter Deszcription Ed |

Cancel |

The following dialog expects you to choose from the list of available options. You can use the first letter of the string, the up/down
arrow keys or the mouse to choose the appropriate option. Then press OK or CANCEL. If you press OK or ENTER it will take the

string and set all selected strings to that value.
Select Top 3 Statistic |

I Ruzhing j

Tackles/Defense

Cancel |




Shorcut Keys for specific fields

The ENTER key will bring up an editing dialog box which can also be used to change any fields which are selected.

Field #:
Description:

Team/Individual:

Top 3:

Game/Season:

Sign #:

Display Mode:

Times to Display:

Drive:
Library:
Sequence:

Frame:

Offset:

- 20 vO

None

None

T Team
Individual

N Normal
reCeiving
Passing

Rushing
Tackles/defense

None
+ Increments Sign Number
- Decrements Sign Number
Cc Continuous
S Single step
F selected Frame
+ Increments Times to Display
- Decrements Times to Display
A-Z changes drive to which ever letter is pressed
None
None
+ Increments Frame Number
- Decrements Frame Number
+ Increments the Offset

- Decrements the Offset



DakStats Baseball will be available soon.
Baseball is one of the six sports that will make up the DakStats results package family.

The Baseball Request file will contain all requests to be sent to the DakStats Baseball computer.



DakStats Basketball is available!
Basketball is one of the six sports that will make up the DakStats results package family.

The Basketball Request file will contain all requests to be sent to the DakStats Basketball computer.



DakStats Football is available!
Football is one of the six sports that will make up the DakStats results package family.

The Football Request file will contain all requests to be sent to the DakStats Football computer.



DakStats Hockey will be available in the future.
Hockey is one of the six sports that will make up the DakStats results package family.

The Hockey Request file will contain all requests to be sent to the DakStats Hockey computer.



DakStats Soccer will be available in the future.
Soccer is one of the six sports that will make up the DakStats results package family.

The Soccer Request file will contain all requests to be sent to the DakStats Soccer computer.



DakStats Volleyball will be available in the future.
Volleyball is one of the six sports that will make up the DakStats results package family.

The Volleyball Request file will contain all requests to be sent to the DakStats Volleyball computer.



Configuration

The Stats Request Application has an initialization file which will need to be configured once. You can edit it with the DOS editor
by opening it using Windows Explorer. The file is located in the main V7000 directory, which in most cases will be:

C:\V7000\STREQUEST.INI

The only setting you should have to set is the VZRTDINPUT. It should be the value of the Venus 7000 input which is connected
to the DakStats computer. This will normally be a value between 1 and 16.

The file appears as follows:

[REQUEST]

V7rtdinput=1 B Venus 7000 port connected to the DakStats computer
Sport=FOOT.REQ

; if V7rtdport is set to 0, it will use the parameters below

; otherwise it will use the parameters of the named V7rtdport(1-16)
Comport=

Parity=

Baud=

Word=

Stopbits=

There may be a few cases in which you do not use the Venus 7000 Sign Service to send the Request. In those cases set the
V7RTDINPUT=0 and set the Comport, Parity, Baud, Word, and Stopbits parameters to match those of the DakStats machine.



Trouble Shooting

If your system doesn’t appear to be functioning correctly, here are some general trouble shooting guides.

Message Box Appears:
Unable to Connect to Sign Service
Not Connected to Venus 7000 Sign Service

Sequence Doesn’t Start
1 Does the Sequence exist on the Venus machine?
2 Does the Library exist on the Venus machine?
3 If you are using Selected Frame mode, Does the Frame Exist?
4 Is the Venus sign configured with the proper sign number?
5 Is the Stats Request INI file configured properly?
6 Is the Venus 7000 RTD Input parameters match the parameters on the DakStats machine?
8 Is the DakStats machine configured properly?
9 Check all cabling between the machines. Make sure all cables are seated firmly.




Unable to Connect to Sign Service

The Stats Request program was unable to communicate with the Venus 7000 Sign Service. This is usually caused by the
Venus Sign Service being Stopped.

To fix this problem, go to the Venus 7000 shell program and Start the Sign Service.

It could also be caused by running the Stats Program on the wrong computer. It was designed to be run on the main Venus
7000 machine.



Not Connected to Venus 7000 Sign Service
To send a request to the DakStats computer. The Stats Request program must connect to the Venus 7000 Sign Service to send

the request. This message box means that the Sign Service is not currently connected so the request could not be sent.

To fix the problem, switch to the Venus 7000 shell and start the Sign Service.



Sequence Not Starting

Make sure the sequence and library exist on the Venus machine.
Both the sequence and library must be 8 or less valid characters.

Be sure to double check the spelling of the Request to make sure it matches the Venus sequence or library.



Normal COM Port Parameters

The DakStats machine uses COM port 2 to interface to the Venus computer with the following parameters:

Baud Rate - 9600
Parity - 'N' for None
Word Length - 8
Stop Bits - 1

Protocol - Enhanced
Buffer Size - 2048 bytes



DakStats Configuration

The DakStats machine must be configured to match the parameters set up on the Venus 7000 machine.

be seen below. Also, the DakStats configuration file can be found on the DakStats machine.

For Basketball, look in the C:\COURT\STBBINT.INI file.
For Football, look in the C:\FOOTBALL\STFBINT.INI file.

Under the [DISPLAY] heading look for the following entry:
SENDSTART=1

If it is not set to 1, it will NOT start the sequence but it will still send the RTD information.

Normal settings can



Stats Request Help Index

How To ...
Edit a Request
Edit Individual Fields of a Request or multiple Requests
Add a Request
Insert a Request
Use the Shortcut Keys
Change Sports
What is a Request
Configure for first time Start Up

Commands
File menu
Edit menu
Record menu
View menu
Window menu

Help menu



File menu commands

The File menu offers the following commands:

Send Request Sends the selected request to the DakStats computer.

Sports Selects the sport to request stats for.

Save Saves the current sports requests.

Print Prints the current sports requests.

Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.

Exit Exits the Stats Request Application.



Edit menu commands

The Edit menu offers the following commands:

Edit
d
Insert
Cut

>
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Edits the selected request by invoking the main edit dialog box.
Adds a request to the end of the document.

Inserts a request in front of the selected request.

Deletes the selected requests and moves it to the clipboard.
Copies the selected requests to the clipboard.

Pastes data from the clipboard into the document.

Deletes the selected requests. It does NOT copy the requests to the clipboard.



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.
Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the
application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.

Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of closed windows.

Split Split the active window into panes.

Window 1, 2, ... Goes to specified window.




Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Help Offers you an index to topics on which you can get help.

Topics
About Displays the version number of this application.




New command (File menu)

Not Used.



File New dialog box

Not Used.



Open command (File menu)

Not Used.



File Open dialog box

Not Used.



Close command (File menu)

Not Used.



Save command (File menu)

Use this command to save the active sport’s requests to the harddrive.

Shortcuts

Toolbar:

Keys: CTRL+S



Save As command (File menu)

Not Used.



Send command (File menu)

Not Used.



File Save As dialog box

Not Used.



1, 2, 3, 4 command (File menu)

Not Used.



Exit command (File menu)

Use this command to end your Stats Request session. You can also use the Close command on the application Control menu.
The Stats Request will prompt you to save the current sport’s requests if it has any unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Not Used.



Redo command (Edit menu)

Not Used.



Cut command (Edit menu)

Use this command to remove the currently selected request(s) from the sport file and put it on the clipboard. This command is
unavailable if there is no request(s) currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:

Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy the currently selected request(s) onto the clipboard. This command is unavailable if there is no
request(s) currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is unavailable if the clipboard
is empty.

Shortcuts

Toolbar:

Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in the Stats
Request Application, such as File Save. A check mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

ElENES

The toolbar is displayed across the top of the application window, below the menu bar.

access to many tools used in the Stats Request Application.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

The toolbar provides gquick mouse

Saves the requests for the current sport.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

T EEEHE D

Deletes selected data from the document.

Edits the selected request.

Adds a request to the document.

Adds a request to the document at the insertion point.

g 5w &

Sends the selected request to the DakStats computer.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected menu item or
depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when the Status Bar is
displayed.

See Status Bar for help on using the status bar.



Status Bar

caP

The status bar is displayed at the bottom of the Stats Request window. To display or hide the status bar, use the Status Bar
command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. This area
similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing them. If after
viewing the description of the toolbar button command you wish not to execute the command, then release the mouse button
while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



New command (Window menu)

Not Used.



Cascade command (Window menu)

Not Used.



Tile command (Window menu)

Not Used.



Tile Horizontal command (Window menu)

Not Used.



Tile Vertical command (Window menu)

Not Used.



Window Arrange lcons Command

Not Used.



Split Command (Window menu)

Not Used.



1, 2, ... command (Window menu)

Not Used.



Index command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step instructions
for using the Stats Request application and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of the Stats Request Application.



Context Help command

Use the Context Help command to obtain help on some portion of Stats Request. When you choose the Toolbar's Context Help
button, the mouse pointer will change to an arrow and question mark. Then click somewhere in the Stats Request window, such
as another Toolbar button. The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

# FODT.REQ - StRequest Mi=] E3
The title bar is located along the top of a window. It contains the name of the application and document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title bars.

Atitle bar may contain the following elements:

Application Control-menu button
Document Control-menu button
Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars indicate your vertical
and horizontal location in the document. You can use the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

&

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you want to move.
2.  Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.
Note: This command is unavailable if you maximize the window.

Shortcut

Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow keys.

&

Note: This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the Stats Request window to an icon.

Shortcut

Mouse: Click the minimize icon E on the title bar.
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon E on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Not Used.



Previous Window command (document Control menu)

Not Used.



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

¥

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Stats Request window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar. This option does not affect applications reduced
to icons.

Tile
Arranges open applications into windows that do not overlap. This option does not affect applications reduced to icons.

Arrange Icons

Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

Not Used.



Choose Font dialog box

Not Used.



Choose Color dialog box

Not Used.



Find command (Edit menu)

Not Used.



Find dialog box

Not Used.



Replace command (Edit menu)

Not Used.



Replace dialog box

Not Used.



Repeat command (Edit menu)

Not Used.



Clear command (Edit menu)

Not Used.



Clear All command (Edit menu)

Not Used.



Next Pane

Not Used.



Prev Pane

Not Used.



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a document using your
application.






No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.






Print command (File menu)

Use this command to print a document.  This command presents a Print dialog box, where you may specify the range of pages
to be printed, the number of copies, the destination printer, and other printer setup options.

Shortcuts

=M

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection. Choose the Setup option to change the printer and printer connection.

Setup
Displays a Print Setup dialog box, so you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Stats Request is sending output to the printer. The page number indicates

the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When you choose this command, the main
window will be replaced with a print preview window in which one or two pages will be displayed in their printed format. The
print preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document;
zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.

Prev Page

Preview the previous printed page.

One Page | Two Page

Preview one or two printed pages at a time.

Zoom In

Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box, where you
specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use. Choose the Default Printer; or choose the Specific Printer option and select one of the
current installed printers shown in the box. You install printers and configure ports using the Windows Control Panel.
Orientation

Choose Portrait or Landscape.

Paper Size

Select the size of paper that the document is to be printed on.

Paper Source

Some printers offer multiple trays for different paper sources. Specify the tray here.
Options

Displays a dialog box where you can make additional choices about printing, specific to the type of printer you have selected.
Network...

Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

Not Used.






